KX Printer Drivers
Printing System

Operation Guide
Legal Notes

Unauthorized reproduction of all or part of this guide is prohibited. The information in this guide is subject to change for improvement without notice.

We cannot be held liable for any problems arising from the use of this product, regardless of the information herein.

Regarding Trademarks

- PCL is a registered trademark of Hewlett-Packard Company.
- Microsoft Windows is a registered trademark of Microsoft Corporation in the U.S. and/or other countries.
- PostScript is either a registered trademark or trademark of Adobe Systems Incorporated in the U.S. and/or other countries.
- TrueType is a registered trademark of Apple Computer Inc.
- All other brand and product names herein are registered trademarks or trademarks of their respective companies.

Examples of operation given in this guide are for a Windows XP printing environment. Essentially the same operations are used for Windows 95/98/Me environments.

Installing the Printer Driver

Refer to the Printer Driver Installation Guide supplied with the Print System for the installation of printer driver.
<table>
<thead>
<tr>
<th>Contents</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Properties</strong> .....................................................................</td>
<td>5</td>
</tr>
<tr>
<td>Accessing Printer Properties</td>
<td>5</td>
</tr>
<tr>
<td>Installing Optional Devices</td>
<td>6</td>
</tr>
<tr>
<td>User Settings</td>
<td>13</td>
</tr>
<tr>
<td>Administrator Settings</td>
<td>17</td>
</tr>
<tr>
<td><strong>Printing from Application Software</strong></td>
<td>19</td>
</tr>
<tr>
<td>Basic printing tasks</td>
<td>19</td>
</tr>
<tr>
<td>Duplex Printing</td>
<td>28</td>
</tr>
<tr>
<td>Cover Mode, Page Insert, and Transparency Interleaving</td>
<td>29</td>
</tr>
<tr>
<td>Booklet Printing</td>
<td>39</td>
</tr>
<tr>
<td>Collating Modes</td>
<td>40</td>
</tr>
<tr>
<td>Rotate Collate</td>
<td>45</td>
</tr>
<tr>
<td>Job Settings</td>
<td>46</td>
</tr>
<tr>
<td>Using Virtual Mailbox</td>
<td>53</td>
</tr>
<tr>
<td>Temporary and Permanent Jobs</td>
<td>57</td>
</tr>
<tr>
<td>Printing Watermarks</td>
<td>61</td>
</tr>
<tr>
<td>Adjusting the Imaging Settings</td>
<td>71</td>
</tr>
</tbody>
</table>

**Notes:**

- The contents listed are typical of a printer user manual, covering topics from basic printer setup to advanced printing options.
- The page numbers indicate the starting page for each section.
- The layout is intended to help users navigate through the manual efficiently.
This section explains how to complete the customization of the installed printer driver. Follow these steps to save your preferred settings as the default settings. These printer settings can be changed temporarily when printing from within applications.

### Accessing Printer Properties

Click the Windows [Start] button and click **Printers and Faxes** to access the **Printers and Faxes** window. (For Windows 95/98/Me, click the [Start] button, then select **Settings** and **Printers** to access the **Printers** window).

1. Right-click on the printer icon in the **Printers and Faxes** window (the **Printers** window in Windows 95/98/Me) to access the drop down list.
Windows 95/98/Me

2. Click [Properties] in the drop down list.

The Properties window will open as shown in the next section.

Installing Optional Devices

If you will use optional devices such as a paper feeder, finisher and/or an additional hard disk, specify them in the [Device Settings] tab of the device properties. You can also specify the memory setting, PDL settings for the user, administrator settings for front panel messages and passwords, and more.

Follow these steps to complete the Device Settings.

1. Click the [Device Settings] tab.

Windows XP
2 In the **Device Options** list, click to add a check mark (✓) in the check boxes for devices installed with your printer.

Some optional devices cannot be installed simultaneously (for example, a finisher and a booklet stitcher). After you select one, the other will be marked with a red [×], preventing additional check marks (✓).

3 If you click to add a check mark (✓) in the check box of an optional device shown in blue, such as the [Finisher] options, a sub-dialog box is displayed for completion of the setting details. If a device listing is already marked with a check mark (✓), double-click on it to access the sub-dialog box. If you select the [Hard Disk] option, the **Hard Disk Settings** dialog box is displayed for virtual mailbox settings. For further details, refer to *Assigning Virtual Mailboxes* on page 9. For details on RAM Disk, refer to *RAM Disk Settings* on page 12.

4 In the **Memory** combo box, specify the memory capacity of your printer. This setting is required to optimize downloading when the printer driver downloads fonts.
5 When you have completed the settings, click the [OK] button. You will return to the Windows **Printers and Faxes** window. (In Windows 95/98/Me, you will return to the **Printers** window.)

**Finisher Punch Settings**

If you click to add a check mark (✓) in the check box for **Finisher** in the **Device Options** list, the **Punch Unit Setting** dialog box is displayed. If the device listing is already marked with a check mark (✓), double-click on it to display the **Punch Unit Setting** dialog box. Select [2 Hole], [2 & 3 Hole], or [2 & 4 Hole] depending on the optional punch unit attached to your finisher to enable punching of the pages you print.

**Booklet Stitcher Punch Settings**

If you click to add a check mark (✓) in the check box for **Booklet Stitcher** in the **Device Options** list, the **Punch Unit Setting** dialog box is displayed. If the device listing is already marked with a check mark (✓), double-click on it to display the **Punch Unit Setting** dialog box. In the same way as for the [Finisher] settings, select
[2 Hole], [2 & 3 Hole], or [4 Hole] depending on the optional punch unit of your finisher to enable punching of the pages you print.

Assigning Virtual Mailboxes

After you assign virtual mailboxes in the hard disk settings, users can post print jobs for printing later. You can specify a maximum of 255 mailboxes and divide the mailboxes among multiple users. For details, refer to Description of Job Option Functions on page 46.

In the Device Options list, if you click to add a check mark (✓) in the check box for Hard Disk, the Hard Disk Settings dialog box is displayed. If the device listing is already marked with a check mark (✓), double-click on it to display the Hard Disk Settings dialog box.
To assign virtual mailboxes in the hard disk settings, follow these steps.

1. Enter the preferred name in **Mailbox Name**. For example, specify the user name or department name. The name can be up to 31 characters long.

2. In **Virtual Output Tray**, enter a number from 1 to 255. You can enter commas and hyphens to organize multiple mailboxes for the same user. In the following example, when the numbers ‘1, 3, 5-12’ are entered, the user specified in **Mailbox**
**Name** is assigned mailboxes 1, 3, 5, 6, 7, 8, 9, 10, 11, and 12, which will simultaneously save the print jobs.

3. After you click the [Add] button, the mailbox will be displayed in the **Defined Names** list at right.

4. To assign multiple mailboxes, repeat the above steps. It is also possible to assign mailboxes using the same mailbox numbers for users with different names. However, be aware that this will result in shared mailboxes.

For instructions on assigning user settings for the mailboxes you have created, refer to the explanation in *Using Virtual Mailbox* on page 53.
To delete a mailbox that you created, select the mailbox from the **Defined Names** list and click the [Delete] button.

When the settings are complete, click the [OK] button to close the **Hard Disk Settings** dialog box.

**RAM Disk Settings**

When no hard disk for printing is installed, the RAM disk performs the same function as a hard disk to save them in a part of the printer’s memory. When a hard disk is installed, no RAM disk can be used. The size of the RAM disk is specified in settings on the printer operator panel. For details, consult the printer option’s *Operation Guide (Function Edition)*.

To specify the correct RAM disk size in the printer driver to match the printer settings, follow the steps below.

1. In the **Device Options** list, click to add a check mark (✓) in the check box for **RAM Disk**. The memory capacity can now be edited in the **RAM Disk** combo box on the bottom right.

2. Specify the **RAM Disk** size.

   The maximum RAM disk capacity varies depending on your printer model and the amount of memory installed. In the example of the 35 ppm copier shown above, it corresponds to 16 MB minus 9 MB, so the maximum available capacity for the RAM disk is 7 MB. Thus, the value in the combo box will not exceed 7 MB even if you attempt to set it higher. For details, consult the printer option’s *Operation Guide (Function Edition)*.
User Settings

The following user information can be specified in the settings by clicking the [User] button in the [Device Settings] tab.

- User name and department identification
- Unit of measurement for custom paper sizes (inches or centimeters)
- Language
- PDL (Page Description Language)

Follow these steps to proceed.

User Identification

You can display the user information for the current print job on the printer operator panel.

1. In the [Device Settings] tab, click the [User] button. The [User Settings] dialog box is displayed.

2. Enter the preferred name in User Name. You can enter up to 31 characters. Enter the group to which the user belongs in Department. This box also accepts up to 31 characters.
This concludes the user identification process.

**Unit of Measurement**

The unit that you specify here will be used as the unit of measurement for the **Custom Paper Sizes** setting in the [Custom] section of the [Media] tab, as well as the [Gutter Settings] setting of the [Layout] tab. You can switch between inches and centimeters by clicking the appropriate radio button.

**Language Preference Selection**

Specifies the language of the driver tabs except **General, Sharing, Ports, Advanced, Color Management**, and **Security**. In the **Language Preference** check box, click to
add a check mark (√). Select the preferred language from the drop down list of the displayed check box.

**PDL (Page Description Language) Settings**

In the [Device Settings] tab, click the [PDL] button. The PDL Settings dialog box is displayed. Depending on your printer model, different PDLs are available. You can choose from [PCL XL], [PCL 5e], or [KPDL]. In general, we recommend [PCL XL].

<table>
<thead>
<tr>
<th>PDL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCL XL</td>
<td>This PDL is the most recent version of HP’s PCL. It includes PCL5e features. Use this PDL for general printing needs.</td>
</tr>
<tr>
<td>PCL 5e</td>
<td>Select this version to specify HP PCL 5e as the PDL.</td>
</tr>
<tr>
<td>KPDL</td>
<td>Select KPDL for a PDL that is compatible with Adobe PostScript 3. Used when printing from PostScript 3-compatible applications.</td>
</tr>
</tbody>
</table>

In **GDI compatible mode**, graphics are processed so that vector graphics are rasterized for printing as bitmap images. Use it for when you want your printout to better match the graphic as created by the application. Because this requires much more memory, the feature is unavailable in certain printing environments. It is also unavailable when KPDL (PostScript-compatible) is selected.
The **Settings** button is available when PDL is either **PCL XL** or **KPDL**. When clicked in **PCL XL**, it opens the **PCL XL Settings** dialog box as show below.

For **KPDL**, clicking the **Settings** button opens the following dialog box.

<table>
<thead>
<tr>
<th>Disable Auto Media Type Switching</th>
<th>Disables the <strong>Media Type</strong> settings in the <strong>Media</strong> tab.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Allow Data Passthrough</th>
<th>Reduces the chance of errors when printing complex jobs from applications that use PostScript.</th>
</tr>
</thead>
</table>

This concludes the PDL (Page Description Language) settings.
Administrator Settings

For details, consult the printer option’s *Operator Guide (Function Edition)*.

Compatibility Settings

Compatibility with this printer driver should be specified if you print from applications that save paper source information within documents, or if the paper source settings are specified by your system environment.

*Note*

These settings values should be changed only by the administrator or another person who understands the features well. Be aware that changing these settings might result in errors.

1. Click the [Compatibility Settings] button to access the *Compatibility Settings* dialog box.

2. From the list in the *Media Source Enumeration* box, select the paper supply method and enter the settings value. The current value is listed in the *Enumerated Value* box. Enter the new value for the list item and click the [Apply] button. You can also restore all the parameters to the default by clicking the [Reset] button.
Printing from Application Software

This section describes instructions for the following printing tasks when printing from Windows applications.

- **Basic printing tasks**
- **Print on Both Sides [Duplex]**
- **Cover mode and page insert features**
- **Booklet printing**
- **Sorting methods**
- **Rotating and collating**
- **Job Settings**
- **Using Virtual Mailbox**
- **Temporary and permanent jobs**

**Basic printing tasks**

The steps required to print a document created with an application are explained below. Here, you will select the printing paper size and output destination.

The following section explains how to print from Microsoft Word as an example.

1. Load paper of the size specified for the document (such as A4) in the application into the printer’s paper cassette.
2. From the application [File] menu, select [Print]. The **Print** dialog box is displayed.
3. Click the drop down list of printer names. All the printers installed in Windows are listed. Click the name of the copier you want to use.
4. Specify the number of copies you want to print in **Number of copies**. You can print up to 999 copies. When printing 2 or more copies, click to add a check mark (✓) in the **Collate** check box for collation into sets.

For Microsoft Word, we recommend that you click the [Options] button and specify **Use printer settings** for the **Default tray**.
5 Click the [Properties] button to access the Properties dialog box.

6 From the [Media] tab, click the Page Size drop down list and select the page size that matches the document to print. The example below shows A4-size selected. For best results when printing on transparencies or recycled paper (the back side of paper which has already been printed on), click the Media Type drop down list and select the media type. For details, refer to Matching the Paper Size before Printing on page 23.

The printer will automatically select paper that matches the size specified above for printing. (If no paper of the right size is available, a message is displayed requesting you to fill the bypass tray.) When you want to specify the cassette for printing, click the Source drop down list to select it.

7 Click the Portrait or Landscape check boxes to match the document page orientation. You can rotate the document 180 degrees by clicking the Rotated check box.

8 Click the [OK] button to return to the Print dialog box.

9 To start printing, in the Print dialog box, click the [OK] button.
Using a Different Print Size Than the Page Size

This section explains how to print documents on paper that is a different size than the size of the original document. The document image will be automatically enlarged or reduced to match the output size.

1. In the **Page Size** drop down list, select the original paper size.
2. Click the **Print Size** drop down list and select the preferred output paper size. Confirm that paper of the size specified in **Print Size** is loaded in the printer.
3. The image will be reduced or enlarged before printing to match the paper size specified in **Print Size**.

When you use this feature, the proportion of the source document page size is compared to the output paper size. In contrast with this, the **Scaling** features explained on page 22 are unrelated to the output paper size. For those features you select a percentage of enlargement or reduction of the original image relative to the original page size. For details, refer to **Scaling** on page 22.

To restore the output page size, in the **Print Size** list, specify **Same as Page Size**.

Printing Multiple Pages Per Sheet

You can print by arranging multiple pages of the source document on a single sheet of paper. From the **Layout** tab, specify the number of source pages in **Pages per Sheet**. For example, if you select 4 pages, 4 pages will be printed on a single sheet as shown in the window in the example below. From the **Layout** list, you can select the left/right layout arrangement. The next example shows when **Auto** is selected, arranging the page from the top left corner to the bottom right corner. Clicking to add a check mark
(✓) in the **Print Borders** check box will show the page borders of each page, which will be printed when selected.

![Print Borders](image)

When this function is selected, the **Scaling** function explained next is unavailable.

**Scaling**

Within the page size specified in **Print Size** in the [Media] tab, you can reduce or enlarge the image before printing in a range from 20% to 500%.

For example, to reduce an image for an A4-sized page by 70%, specify 70% in the **Advanced Layout Settings** box. The page will be reduced as shown in the example in the window below. Clicking the [Advanced] button allows you to adjust the outside margins in a range from 5 mm to 25.4 mm.

Click the **Left (Long Edge)** or **Top (Short Edge)** check boxes to set the margin for the **Left (Long Edge)** or **Top (Short Edge)** side of the paper. Clicking the check box to add a check mark (✓) in the **Reduce Image to fit** check box will reduce the margins to match to the page size reduction.

![Advanced Layout Settings](image)
When you want to change the page size to another page size (for example, to enlarge an A4-size brochure for printing on A3 paper), use the convenient feature explained on page 21 in Using a Different Print Size Than the Page Size.

Matching the Paper Size before Printing

Assuming that you will print on regular paper, by default the printer automatically selects paper of the size specified in the Page Size setting in the Media tab. However, the printer supports all kinds of printing media depending on the model. If you use recycled paper, labels, or transparencies, you can specify it in the Media Type setting for automatic selection of the paper source. You can also specify the finishing settings for the best printing results.

When paper is loaded correctly in the paper cassette, the printer can automatically detect the paper size. However, it is necessary to use the print operator panel on the printer to assign the media type of the paper cassette so that the printer can associate it. Labels, transparencies, envelopes, and the like cannot be printed from the paper cassette. These media are printed using the bypass tray, so follow the instructions in the copier’s Operation Guide to ensure the paper is supplied correctly.

To specify the media settings. Follow the instructions below to proceed.

1 Load the paper in the paper cassette or bypass tray. The bypass tray is used in cassette mode. For information on the bypass tray modes, refer to the copier’s Operation Guide.
2 Specify the media type in the print operator panel on the copier. For details, consult the copier’s Operation Guide.
3 Access the printer Properties and click the [Media] tab. For further details, refer to page 19.
4 Select the document paper size in Page Size.
5 From the **Media Type** drop down list, select the type of media for printing.

![Screenshot of media type options](image)

Your options for media listed in the **Media Type** drop down list are as follows. This information on media type also applies for **Custom Paper Sizes**.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Available Cassettes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>All</td>
</tr>
<tr>
<td>Transparency</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>Preprinted</td>
<td>All</td>
</tr>
<tr>
<td>Labels</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>Bond</td>
<td>All</td>
</tr>
<tr>
<td>Recycled</td>
<td>All</td>
</tr>
<tr>
<td>Vellum</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>Rough</td>
<td>All</td>
</tr>
<tr>
<td>Letterhead</td>
<td>All</td>
</tr>
<tr>
<td>Color</td>
<td>All</td>
</tr>
<tr>
<td>Prepunched</td>
<td>All</td>
</tr>
<tr>
<td>Envelope</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>Card Stock</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>Thick</td>
<td>Bypass Tray</td>
</tr>
<tr>
<td>Custom1 (to 8)</td>
<td>Bypass Tray</td>
</tr>
</tbody>
</table>

6 Click the **[OK]** button to close the properties window.

7 When you start printing, the printer will automatically select paper to match the paper size and media type specified above.

If no loaded paper matches the size, type, or both size and type, a message will be displayed requesting you to load paper in the bypass tray.
Printing on Paper of Non-Standard Sizes

The printer can print on custom sizes of paper. For custom paper, supply the paper using the universal (adjustable) paper cassette or the bypass tray.

Do the following before printing on custom paper.

• Specify the page size of the custom paper in the printer driver and save the settings. To do this, access the printer driver properties in Windows by clicking the [Start] button and then selecting the Printers and Faxes window. (In Windows 95/98/Me, select the Printers window.) For further details, refer to the instructions below.
• Load the custom paper in the printer. For details, consult the copier’s Operation Guide.

Follow these steps to save custom page sizes in the printer driver.

1 From the application [File] menu, select [Print]. The Print dialog box is displayed.
2 Click the [Properties] button to access the Properties dialog box.
3 Click the [Media] tab.
4 Click the [Custom] button. The Custom Paper Sizes dialog box is displayed.

5 In the Custom Paper Sizes dialog box, click the [Add] button. The Add Paper Size dialog box is displayed.
6 Enter a name for your custom size in the **Name** box. (The name can be up to 31 characters long.)

![Add Paper Size](image)

Enter the appropriate measurements in the **Height** and **Width** boxes in millimeters or inches. (Units are selected from the **User** dialog box of the [Device Settings] tab.

The following sizes are available for custom paper.

<table>
<thead>
<tr>
<th>Size</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>98 mm to 148 mm</td>
</tr>
<tr>
<td>Largest (A3 copiers)</td>
<td>297 mm to 432 mm</td>
</tr>
</tbody>
</table>

Sample Paper Measurements (150 mm x 200 mm)
Printing from Application Software

7  Click the [OK] button to save the page size and return to the **Custom Paper Sizes** dialog box. You can confirm the name of paper size you added.

8  Click the [OK] button.
    Repeat the procedure above if you want to add other custom paper sizes.

**Printing with Custom Paper Sizes**

To print on paper of the custom paper size specified above, follow these steps.
Access the printer properties from within the application. (Select **Print** from the **File** menu.) From the **Media** tab, select the name of your saved paper size in the **Page Size** drop down list. Click to select the custom paper size for printing. Next, select the source cassette of the custom paper from the **Source** drop down list.
Click the [OK] button and start printing.
Duplex Printing

Instructions are given below for printing on both sides of paper using printers equipped with duplexers. In duplex printing, you can choose between a method for binding along the paper’s long edge or short edge.

Duplex printing may require additional memory depending on the model. For details, consult the printer option’s Operation Guide (Function Edition).

Follow these steps for duplex printing.

1. Access the printer properties and click the [Layout] tab.
2. Click to add a check mark (✓) in the check box for Print on Both Sides [Duplex]. Choose either Flip on Long Edge or Flip on Short Edge.

3. Click the [OK] button and start printing.

![Duplex Printing Options](image-url)

Flip on Long Edge
<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image-url" alt="Flip on Long Edge Portrait" /></td>
<td><img src="image-url" alt="Flip on Long Edge Landscape" /></td>
</tr>
</tbody>
</table>

Flip on Short Edge
<table>
<thead>
<tr>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image-url" alt="Flip on Short Edge Portrait" /></td>
<td><img src="image-url" alt="Flip on Short Edge Landscape" /></td>
</tr>
</tbody>
</table>
Printing from Application Software

Cover Mode, Page Insert, and Transparency Interleaving

Use Cover Mode to add a front or back cover to your document. Page Insert inserts blank or printed pages before pages in your document. Transparency Interleaving inserts a blank or printed page between each transparency.

The Cover Mode and Page Insert settings are only available when the PDL is PCL XL or KPDL. For instructions on changing the PDL, refer to PDL (Page Description Language) Settings on page 15.

Printing with Covers

For your document’s front cover or front and back covers, you can insert and print on paper that is heavier or a different color than the paper for the body of the document. You can also specify cover printing when completing booklet printing settings. The paper used for printing the document body is specified in the [Media] settings of the Properties dialog box. The source of the cover paper is specified by adjusting settings in the Advanced Media Settings dialog box. You can also print on the covers.

To print using the Front Inside or Front Outside functions, you must have a duplexer attached. You must also specify Print on Both Sides [Duplex] on the settings of the [Layout] tab of the printer driver. Although the Cover Mode functions may be used together with Page Insert functions, they cannot be used with Transparency Interleaving. For details on printing with covers in the booklet printing settings, refer to Booklet Printing on page 39.

1. From the application’s Print dialog box, access the printer Properties. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).
2. In the properties dialog box, click the [Media] tab, and then click the [Advanced] button. 1
3 Click to add a check mark (✓) in the **Cover Mode** check box.

4 To insert only a front cover, select **Front**. To insert a front and back cover, select **Front and Back**.

5 For printing on the front or back covers, click to add a check mark (✓) in the check box corresponding to your desired arrangement as shown in the following table.
## Options for Cover Printing (Sheet 1 of 3)

<table>
<thead>
<tr>
<th>Check Box Selection</th>
<th>Cover Insertion Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Front" /></td>
<td>Inserts a blank front cover</td>
</tr>
<tr>
<td><img src="image" alt="Front" /></td>
<td>Prints on the outside surface of the front cover</td>
</tr>
<tr>
<td><img src="image" alt="Front" /></td>
<td>Prints on the inside surface of the front cover</td>
</tr>
<tr>
<td><img src="image" alt="Front" /></td>
<td>Prints on the outside and inside surfaces of the front cover</td>
</tr>
</tbody>
</table>

*Note: Images of diagrams are not provided in the text.*
Options for Cover Printing (Sheet 2 of 3)

<table>
<thead>
<tr>
<th>Check Box Selection</th>
<th>Cover Insertion Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Front and Back</td>
<td>Inserts blank front and back covers</td>
</tr>
<tr>
<td>☑ Front and Back</td>
<td>Prints on the outside surface of the front cover and inserts a blank back cover</td>
</tr>
<tr>
<td>☑ Front Outside</td>
<td>Prints on the inside surface of the front cover and inserts a blank back cover</td>
</tr>
<tr>
<td>☑ Front Inside + Duplex Printing (page 28)</td>
<td>Prints on both sides of the front cover and inserts a blank back cover</td>
</tr>
</tbody>
</table>

Diagram:
- Front and Back: Inserts blank front and back covers
- Front and Back; Front Outside: Prints on the outside surface of the front cover and inserts a blank back cover
- Front and Back; Front Inside + Duplex Printing (page 28): Prints on the inside surface of the front cover and inserts a blank back cover
- Front and Back; Front Outside; Front Inside + Duplex Printing (page 28): Prints on both sides of the front cover and inserts a blank back cover
Options for Cover Printing (Sheet 3 of 3)

<table>
<thead>
<tr>
<th>Check Box Selection</th>
<th>Cover Insertion Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Front and Back</td>
<td>Prints on the outside surface of the back cover and inserts a blank front cover</td>
</tr>
<tr>
<td>✓ Back Inside</td>
<td></td>
</tr>
</tbody>
</table>

![Diagram 1]

| ☑ Front and Back     | Prints on the inside surface of the back cover and inserts a blank front cover |
| ✓ Back Outside       |                                     |
| Duplex Printing (page 28) |                                   |

![Diagram 2]

| ☑ Front and Back     | Prints on both sides of the back cover and inserts a blank front cover |
| ✓ Back Inside        |                                     |
| ✓ Back Outside       |                                     |
| Duplex Printing (page 28) |                                   |

![Diagram 3]

| ☑ Front and Back     | Prints on both sides of the front and back covers |
| ✓ Front Outside      |                                     |
| ✓ Front Inside       |                                     |
| ✓ Back Inside        |                                     |
| ✓ Back Outside       |                                     |
| + Duplex Printing (page 28) |                                   |

![Diagram 4]
6 From the **Media for Cover** drop down list, select the source cassette for the front and back covers.

![Advanced Media Settings dialog box](image)

7 Click the **[OK]** button to return to the **Media** dialog box. Click the **[OK]** button again to return to the print dialog box.

8 Load the paper for your front or back cover in the paper cassette. Click the **[OK]** button and start printing.

**Page Insert**

You can insert a preprinted page or a page of a different paper type before a designated page. You can also print on that page.

**Note**

To print using the **Print onto Back** function, you must have a duplexer attached. You must also specify **Print on Both Sides [Duplex]** on the settings of the **[Layout]** tab of the printer driver. Although the Page Insert functions may be used together with Cover Mode functions, they cannot be used with Transparency Interleaving.

1 From the application’s **Print** dialog box, access the printer **Properties**. For further details, refer to **Basic printing tasks**, steps 2 to 6 (page 19).
2 In the properties dialog box, click the [Media] tab, and then click the [Settings] button.

![Image of properties dialog box]

3 Click to add a check mark (✓) in the Page Insert check box.

![Image of Advanced Media Settings dialog box]

4 For printing with inserted pages, click to add a check mark (✓) in the check box corresponding to your desired arrangement as shown in the following table.
## Options for Printing with Inserted Pages

<table>
<thead>
<tr>
<th>Check Box Selection</th>
<th>Printing Inserted Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Page Insert</td>
<td>Inserts a blank page before the second page</td>
</tr>
<tr>
<td>✓ Page Insert ✓ Print onto Front</td>
<td>Prints on the outside surface of the inserted page</td>
</tr>
<tr>
<td>✓ Page Insert ✓ Print onto Back + Duplex Printing (page 28)</td>
<td>Prints on the inside surface of the inserted page</td>
</tr>
<tr>
<td>✓ Page Insert ✓ Print onto Front ✓ Print onto Back + Duplex Printing (page 28)</td>
<td>Prints on both sides of the inserted page</td>
</tr>
</tbody>
</table>

5 To print on both the front and back of the inserted page, click to add check marks (√) in the check boxes for Print onto Front and Print onto Back.
6 Enter the page number of the page for insertion. A page will be inserted between
the page number you entered and the page before it. You can designate for pages
to be inserted starting from page 2 and ending on page 255. To designate several
pages in the document for insertion, enter a comma (,) to separate them. For a
series of insertions in a range of pages, use a hyphen (-). For example, to insert a
page before pages 5, 11, 12, 13, and 18, enter ‘5, 11-13, 18’.

7 From the Media for Page drop down list, select the source paper cassette.

8 Click the [OK] button to return to the Media dialog box. Click the [OK] button
again to return to the print dialog box.

9 Load the paper for insertion in the paper cassette. Click the [OK] button and start
printing.

Transparency Interleaving

This function avoids damaging the transparencies, inserting a sheet of paper between
them. This function is only available when printing transparencies supplied from the
bypass tray. On these inserted pages you can print the same content as for the
transparencies.

Transparency Interleaving functions cannot be used together with Cover Mode
or Page Insert functions.
1 From the application’s **Print** dialog box, access the printer **Properties**. For further details, refer to **Basic printing tasks**, steps 2 to 6 (page 19).

2 From the properties dialog box, click the **[Media]** tab. Click the **Source** drop down list and select **Bypass Tray**. Next, click the **Media Type** drop down list and select **Transparency**.

3 Click the **[Settings]** button to access the **Advanced Media Settings** dialog box. Click to add a check mark (✓) in the **Transparency Interleaving** check box.

4 To print the transparency content on the inserted pages as well, click to add a check mark (✓) in the **Print onto Backing** check box.

5 From the **Media for Backing** drop down list, select the source paper cassette.

6 Click the **[OK]** button to return to the **Media** dialog box. Click the **[OK]** button again to return to the print dialog box.

7 Load transparency in the bypass tray. Click the **[OK]** button and start printing.
Booklet Printing

Booklet printing is available with printers equipped with duplexers. Stapling and binding requires optional document finishers. This function requires a hard disk on your printer. Printing a four-page document as a booklet, for example, will result in automatic duplex printing in the order of the arrangement shown below. You can choose between left-edge binding and right-edge binding. You can also print on the covers at the same time. For further details, refer to Printing with Covers on page 29.

**Left Edge Binding**

![Diagram of left edge binding]

**Right Edge Binding**

![Diagram of right edge binding]

The supported paper sizes for Booklet Mode printing are A3, ledger, B4, A4, and letter size.

**Note**

To print in booklet mode, follow the instructions below.

1. From the application’s Print dialog box, access the printer Properties. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).
2. Access the printer properties and click the [Layout] tab.
3 Click to add a check mark (✓) in the check box for **Booklet Mode**. Choose either **Left Edge Binding** or **Right Edge Binding**.

![Left Edge Binding](image1)

![Right Edge Binding](image2)

Click the [OK] button to exit the dialog box.

**Collating Modes**

By attaching a sorter to your copier, you can specify how printed documents are grouped as they are stuck in the output trays after printing. The number of output trays and their receiving capacity (the number of sheets) varies depending on the sorter model, so consult your sorter’s *Operation Guide* to check.

Sorters work in three modes: collating mode, non-collating mode, and mailbox mode. See below for an explanation of each mode. In collating, non-collating, and mailbox modes, specify the **Output** as **[Mailbox [Face-down]]**.

Depending on the application, sometimes the application settings are given priority, causing a change in the sorter output method.
## Sorter Mode Differences (Sheet 1 of 2)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collating</td>
<td>Collating produces the specified number of copies as complete sets of documents in each tray. The document is printed following the page order and received in each tray. The number of document copies must not exceed the number of trays. If a tray becomes full, the printer pauses and displays a message to remove the paper from the tray. After the paper is removed, printing resumes for the remaining number of copies.</td>
</tr>
<tr>
<td>Non-collating</td>
<td>Non-collating produces the specified number of copies but divides the document for output in each tray, with page 1 in tray 1, page 2 in tray 2, and so on. For example, printing 20 copies of a four-page document using grouping produces 20 copies of page 1 in tray 1, 20 copies of page 2 in tray 2, and so on. The number of document copies must not exceed the sheet capacity of any tray. If a tray becomes full, the printer pauses and displays a message to remove the paper from the tray. In addition, the maximum document page length must not exceed the number of sorter trays. If a tray becomes full, the printer pauses and displays a message to remove the paper from the tray.</td>
</tr>
</tbody>
</table>
To select these modes from the printer driver’s [Output] tab, proceed as follows.

**Collating**

1. Access the printer properties and click the [Output] tab.
2. From the Output to drop down list, select Mailbox [Face-down].

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox</td>
<td>Mailbox is a mode that produces copies in specified users’trays, which is useful when the printer is shared among different users. For example, specifying tray 5 produces a copy of the document in tray 5. If a tray becomes full, the printer pauses and displays a message to remove the paper from the tray.</td>
</tr>
</tbody>
</table>

To select these modes from the printer driver’s [Output] tab, proceed as follows.

**Collating**

1. Access the printer properties and click the [Output] tab.
2. From the Output to drop down list, select Mailbox [Face-down].

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailbox</td>
<td>Mailbox is a mode that produces copies in specified users’trays, which is useful when the printer is shared among different users. For example, specifying tray 5 produces a copy of the document in tray 5. If a tray becomes full, the printer pauses and displays a message to remove the paper from the tray.</td>
</tr>
</tbody>
</table>

3. For collating, click to add a check mark (✓) in the Collate check box. Enter the number of complete sets in Copies. When you print using collating, specify a
number of copies that does not exceed the number of trays. The document page length must not exceed the tray capacity (for example, 200 sheets).

4 When you want to reverse the page order, click to add a check mark (√) in the Reverse Page Order check box.

5 Click the [OK] button and start printing. The specified number of copies will be produced in separate trays.

Non-collating

1 Clearing the check mark (√) from the Collate check box will produce page 1 in tray 1, page 2 in tray 2, and so on.

2 When you want to reverse the page order, click to add a check mark (√) in the Reverse Page Order check box.

3 Click the [OK] button and start printing. The specified number of copies will be produced in each tray.
Mailbox Mode

To use the sorter in mailbox mode, click the Output to drop down list and select Mailbox [Face-down] as above.

Click to add a check mark (✓) in the Mailbox check box. Select the desired output tray (Mailbox 1, for example) from the drop down list at right. To restore the default settings, click the [Restore Defaults] button.

Click the [OK] button and start printing. The document will be produced in tray 1 (Mailbox1).

Other Output Functions

If the finisher is attached in the [Device Settings] in the printer properties, you can use Staple, Offset, or Punch functions on the [Output] tab. For further details, refer to Printer Properties on page 5.
Rotate Collate

The Rotate Collate function lays the sets produced in the top tray in alternating orientations.

Before printing, load paper of identical sizes in two cassettes (for example, A4 and A4-R), arranging them in opposite orientations. You can also supply paper from the bypass tray.

This function requires a hard disk on the printer or a RAM disk.

1. Access the printer properties and click the [Output] tab.
2. Click the Output to drop down list and select either [Printer Default] or [Inner Tray] as the destination.
3. In the Collate check box, click to add a check mark (✓). Enter the number of copies in Copies and click to add a check mark (✓) in the Rotate Collate check box. The document page length must not exceed the tray capacity.
4. When you want to reverse the page order, click to add a check mark (✓) in the Reverse Page Order check box.

To restore the default settings, click the [Restore Defaults] button.

Click the [OK] button and start printing.
Job Settings

The Job Settings function is available when you install an optional hard disk on the printer. For instructions on installing the hard disk, refer to the supporting manuals, such as the printer option’s *Operation Guide (Function Edition)*.

Job Settings offers a variety of functions as listed below.

Depending on the application, sometimes the application settings are given priority, causing a change in the output method.

### Description of Job Option Functions

<table>
<thead>
<tr>
<th>Printer Driver Menu Item</th>
<th>Function</th>
<th>Job Deletion after Printing</th>
<th>Protected by Access Code</th>
<th>Default Number of Pages Printed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick Copy</strong></td>
<td>After printing a job, you can print it again from the printer operator panel.</td>
<td>Saved until printer power is turned off</td>
<td>No</td>
<td>Same as for original job (adjustable)</td>
</tr>
<tr>
<td><strong>Proof and Hold</strong></td>
<td>When you print multiple copies, the printer produces one copy for proofing and pauses. You can resume printing the remaining copies from the printer operator panel. Useful for when you want to check a single copy before printing all copies.</td>
<td>Saved until printer power is turned off</td>
<td>No</td>
<td>One fewer than original job (adjustable)</td>
</tr>
<tr>
<td><strong>Private Print</strong></td>
<td>Saves print jobs (without printing them) for printing later using the printer operator panel. Printing with this function requires inputting of a access code.</td>
<td>Deleted after printing</td>
<td>Yes</td>
<td>Same as for original job (adjustable)</td>
</tr>
<tr>
<td><strong>Job Storage</strong></td>
<td>This function is for saving frequently used office forms to print later as needed. You can print the required number of copies later from the printer operator panel.</td>
<td>Saved until manually deleted</td>
<td>Optional</td>
<td>1</td>
</tr>
</tbody>
</table>

Each Job Option function is explained in the sections below.
Quick Copy

To print using Quick Copy, follow these steps.

1. From the application’s Print dialog box, access the printer Properties. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).

2. In the Properties dialog box, click the [Output] tab. Click the [Job Settings] button.

3. In the Job Settings dialog box, click to add a check mark (√) in the Job Storage (e-MPS) check box. For Quick Copy printing, select Quick Copy.
You can name the job for later reference when printing from the print operator panel. In Job Name, select Application Defined for automatic naming by the application. Or, select Custom to enter a name of your choice. The name can be up to 39 characters long.

Click the [OK] button to complete the settings.

When you print from the application, it will be saved to the hard disk while the specified number of copies is printing.

For an explanation on printing additional copies of a Quick Copy job afterwards, refer to the printer option’s Operation Guide (Function Edition).

Proof and Hold

To print using Proof and Hold, follow these steps.

1. Access the Job Settings dialog box as indicated in the instructions for Quick Copy on page 47. Select Proof and Hold.
2 You can name the job for later reference when printing from the print operator panel. Or, select Application Defined for automatic naming by the application. In Job Name, select Custom to enter a name of your choice. The name can be up to 39 characters long.

3 Click the [OK] button.

When printing a Proof and Hold job of multiple copies, only the first copy will be printed and the rest are saved. After checking the first copy, follow these steps to print the remaining copies.

Printing the Remaining Copies of Proof and Hold Jobs

You can print the remaining copies of Proof and Hold jobs. Refer to printer option’s Operation Guide (Function Edition) for details. Use the keys on the copier operator panel to proceed. Be aware that for the Proof and Hold function, the number of copies displayed will be one less than the total because you printed one copy for proofing.

Proof and Hold jobs remain saved on the hard disk until the copier is switched off. To delete jobs manually, refer to printer option’s Operation Guide (Function Edition).

Private Print

Private Print jobs are saved to the hard disk for printing later after a four-digit access code is entered. The saved jobs are deleted as soon as they are printed.

To print using Private Print, follow these steps.
1. Access the **Job Settings** dialog box as indicated in the instructions for *Quick Copy* on page 47. Select **Private Print**.

2. You can name the job for later reference when printing from the print operator panel. Or, select **Application Defined** for automatic naming by the application. In **Job Name**, select **Custom** to enter a name of your choice. The name can be up to 39 characters long.

3. For the **Access Code**, enter a four-digit number with your choice of numbers between 0 and 9. When you want to print the saved jobs, enter the access code on the print operator panel.

4. Click the [OK] button.

   When you a Private Print job print, the job will be saved to the hard disk without printing.

   To print Private Print jobs, refer to the printer option’s *Operation Guide (Function Edition)*.
Job Storage

The Job Storage function works the same as Private Print by saving jobs on the hard disk (without printing them) for printing as needed later. The jobs remain saved even after printing and after the printer is switched off. You can also use access codes to restrict the printing of forms.

Follow these steps to use Job Storage for saving jobs to the hard disk.

1. Access the **Job Settings** dialog box in as explained on page 47 for *Quick Copy*. Select **Job Storage**.

2. Click to add a check mark (✓) in the **Access Code** check box. Enter the desired four-digit access code using numbers between 0 and 9. When you want to print the saved jobs, enter the access code on the print operator panel.

3. You can name the job for later reference when printing from the print operator panel. In **Job Name**, select **Application Defined** for automatic naming by the application. Or, select **Custom** to enter a name of your choice. The name can be
up to 39 characters long. When saving forms, it is convenient to name them using the form name.

4 Click the [OK] button.

When you select to print, the job will be saved to the hard disk without printing. To print jobs saved by this procedure, refer to the printer option’s *Operation Guide (Function Edition)*.

**Printing Jobs Saved Using Job Storage**

To print forms and other documents saved using Job Storage, refer to the printer option’s *Operation Guide (Function Edition)*.

The stored jobs will remain saved even after the printer is switched off. To delete them manually, refer to the printer option’s *Operation Guide (Function Edition)*. When deleting jobs, you must enter the same access code as saved in the Job Storage procedure.
Using Virtual Mailbox

With the Virtual Mailbox function, mailboxes created on the hard disk are assigned to multiple users. Jobs posted to a virtual mailbox can be printed later using the printer operator panel.

Virtual Mailbox is available when the printer is set to emulate HP PCL 5e, PCL XL, or PCL 5c. For information on emulation settings, refer to PDL (Page Description Language) Settings on page 15

You must create virtual mailboxes using the printer driver before you can use them. When creating them, you specify a mailbox name and number. Printing will be performed using this name as the job is saved to the mailbox. (Refer to the next page, Creating Virtual Mailboxes). You can group multiple mailboxes and identify the group with a single name.

Regarding mailbox use, it is possible to save jobs in one mailbox, in multiple mailboxes, or in all mailboxes at the same time.

Up to 255 mailboxes can be used. The total mailbox capacity varies depending on the printer model and the size of the hard disk installed. For the specific virtual mailbox capacity of each model, refer to the printer option’s Operation Guide (Function Edition).

The jobs saved in the virtual mailboxes are automatically deleted after printing. Jobs that have not been printed are saved even after the printer is switched off.

Overview of Virtual Mailbox

Instructions for using virtual mailboxes are described in the following sections.

• Creating Virtual Mailboxes
Creating Virtual Mailboxes

Access the printer driver Properties to create virtual mailboxes for each user. For instructions on accessing the Properties, refer to Accessing Printer Properties on page 5.

See Assigning Virtual Mailboxes on page 9 for further details.

Saving Jobs in Virtual Mailboxes

Follow these steps to save jobs to virtual mailboxes.

1. From the application’s print menu, access the properties. (Select [Print] from the [File] menu).

2. In the Properties dialog box, click the Output tab.
3 Click the [Job Settings] button to access the Job Settings dialog box.

4 Click to add a check mark (✓) in the Job Storage (e-MPS) check box. Next, select Virtual Mail Box [VMB].

![Job Settings dialog box](image)

If the Virtual Mail Box [VMB] radio button is inactive, no virtual mailboxes have been created yet. Follow the steps for Assigning Virtual Mailboxes on page 9 to create virtual mailboxes.
5 Click the [Selection] button to access the Virtual Mailbox Selection dialog box. Click to select the virtual mailbox that will store the job.

6 Click the [OK] button to close the Virtual Mailbox Selection dialog box.

7 Close the Properties dialog box.

8 Start printing. The job will be saved to the virtual mailbox on the hard disk. At this point, it is not printed yet.

You can print a list of jobs saved in virtual mailboxes as a VIRTUAL MAIL BOX LIST. For information on printing the list, refer to the printer option’s Operation Guide (Function Edition), Printing Virtual Mailbox Job Lists.
Temporary and Permanent Jobs

Functions for jobs saved as Temporary and Permanent jobs resemble the functions for Quick Copy and other features described in Job Settings on page 46. However, these functions are provided for backward compatibility with printing environments developed before the Job Option functions.

Temporary and Permanent functions use electronic sorting for faster printing of jobs with multiple copies, just as Job Option functions do. The main advantage is that jobs are controlled with internal codes, enabling printing after saving with the Printer Disk Manager application. In addition, it supports bar code printing, in which you can use an optional bar code reader for printing later.

There is one significant difference between Temporary and Permanent jobs. Although both types are saved on the hard disk until it reaches full capacity, when the capacity is exceeded, the Temporary jobs will automatically be deleted but the Permanent jobs will remain.

Printing and Saving Temporary and Permanent Jobs

Check that your printer has an optional hard disk installed. For information on hard disk settings, refer to Assigning Virtual Mailboxes on page 9.

Access the printer driver properties.

1. From the application's print menu, access the properties. (Select [Print] from the [File] menu).
2. In the Properties dialog box, click the [Output] tab.
3. Click the [Job Settings] button to access the Job Settings dialog box.
4 Click to add a check mark (√) in the **Job Storage (e-MPS)** check box. Select **Temporary** or **Permanent**.

5 Click the **OK** button. Afterwards, the job will be printed while it is saved on the hard disk as either a Temporary or Permanent job.

**Using the Barcode Reader to Print Additional Copies of Saved Jobs**

The optional barcode reader enables printing additional copies of saved jobs. When initially printing a job, follow the steps below to print a bar code representing the job code on each page or on the cover page only. After using the barcode reader to read the barcode, you can print either that page or the entire job.

The steps for printing the barcode read by the barcode reader are described below.

1 In the printer driver, click the **Output** tab, and then click **Settings** to access the **Job Settings** dialog box. For further details, refer to *Printing and Saving Temporary and Permanent Jobs* on page 57.
2 Click to add a check mark (✓) in the Job Storage (e-MPS) check box. Select Temporary or Permanent.

3 Click the [Options] button to access the Job Storage Options dialog box.

4 Click to add a check mark (✓) in the Barcode check box. Select Print on first page only or Print on all pages. Clicking to add a check mark (✓) in the Print Barcode ID check box will print the job code as a barcode with a numeric code as shown in the figure below.

5 From the Position drop down list, select the page position for the barcode. From Orientation, select the direction that the barcode faces.

The various combinations are shown in the figure below.
6 Click the [OK] button to close the Job Storage Options dialog box.

When you print, the barcode will be printed in the designated position. The method for reading the job code from the barcode is described below.

**Reading with the Barcode Reader**

When you use the barcode reader to read the printed barcode, the printer will print that page. When you read the barcode on the cover page, all pages will be printed, and reading individual pages will print only those pages.

To connect the barcode reader to the printer, use the printer’s serial interface. This requires switching the serial interface mode for the barcode reader, so refer to the barcode reader’s Operation Manual.

### Barcode Printing Positions and Orientations

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Upper Right</th>
<th>Lower Right</th>
<th>Upper Left</th>
<th>Lower Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal</td>
<td><img src="image1" alt="Barcode 1" /></td>
<td><img src="image2" alt="Barcode 2" /></td>
<td><img src="image3" alt="Barcode 3" /></td>
<td><img src="image4" alt="Barcode 4" /></td>
</tr>
<tr>
<td>Vertical</td>
<td><img src="image5" alt="Barcode 5" /></td>
<td><img src="image6" alt="Barcode 6" /></td>
<td><img src="image7" alt="Barcode 7" /></td>
<td><img src="image8" alt="Barcode 8" /></td>
</tr>
</tbody>
</table>

Using the Barcode Reader to Read the Job Code
Printing Watermarks

In watermark printing, your preferred text is printed in the document background to label it. You can choose one of four standard watermarks or enter your own text.

Selecting the Watermark

The watermark settings are described below.

1. From the Print dialog box of the application, access the printer Properties. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).

2. In the Properties dialog box, click the [Watermark] tab.

3. Click to remove the check mark (✓) from the Disable Feature check box.

4. From the Watermark Selection drop down list, click to select the text. This drop down list displays four standard watermarks and watermarks you have added. For instructions on adding watermarks, refer to Adding Watermarks on page 62.
Adding Watermarks

You can enter your preferred text for a new watermark. The text font, color, size, and style are editable for the new watermark.

1. From the Print dialog box of the application, access the printer Properties. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).
2. In the Properties dialog box, click the [Watermark] tab.
3. Click to remove the check mark (√) from the Disable Feature check box.
4. Click the [Add] button. The Watermark Properties dialog box is displayed.
5 Click the [Text Definition] tab. Name your watermark in the Watermark Description text box, and enter the text to be printed as a watermark in the Watermark Text text box.

6 In the Text Attributes section, specify the Font. Select a font from the Font drop down list.

7 In the Text Attributes section, specify the Color setting. For monochrome printers, select 10% Gray to 90% Gray or Black in the Color drop down list.
For color printers, select the color for the watermark text from the **Color** drop down list, or select **Custom** to choose additional colors.

In the window shown above, selecting **Custom** will display the basic Windows system colors for your selection. Besides the basic system colors, you can also create customized colors. Click **Custom** to display the **Color** dialog box (below). To select one of the basic colors, click to choose from **Basic colors**, and then click the [OK] button.
To create your own color, click the **Define Custom Colors** button to display the color matrix.

Drag the pointer over the color matrix to adjust the **Hue** and **Sat** levels. Drag the pointer left or right to adjust the **Hue** and up or down to adjust the **Sat**. Alternatively, you can enter numerical values for the hue and other color attributes.

To adjust the **Lum** level, drag the slider on the right of the color matrix. You can also enter a number for the setting. Colors that you create are displayed in **Color/Solid**.

Click the **Add to Custom Colors** button to register your color among the **Custom colors**. Click the **OK** button to save the **Custom colors**. The color will
be applied the text. Click the [OK] button to return to the Watermark Properties dialog box.

8 In the Text Attributes section, specify the font Size. Increase or decrease the value of the Size box as needed. The font size is measured in points.

9 In the Text Attributes section, specify the Style of typeface. From the Style drop down list, select among italic, bold, and other options.

10 Click the [OK] button to complete the Text Definition settings.

Positioning Watermarks

You can specify where the watermark is printed on the page.

1 Click the [Position] tab. To specify the Text Position, select either Center on Page or User Defined. Selecting User Defined allows you to specify a watermark position relative to the page center by entering x and y values for the horizontal and vertical coordinates.
**Manual Adjustment**: You can click the **Move** radio button and hold the left mouse button while dragging the watermark image at left to the desired position.

2 Specify the **Text Angle**. Click to select a preset **Diagonal** display (slanted to the upper right) or to select **Angle**, which enables you to enter your preferred angle (measured counterclockwise from 0° to 360°). If you select **Angle**, drag the slider horizontally or enter the value to set the angle. Additionally, you can rotate the text around a point in the center of the text in 360°. Select **User Defined** in the **Text Position** and click **Angle** in the **Text Angle**. The Enable Rotation around Center of Text checkbox is displayed. Click to add the check mark (√) in the checkbox.

**Manual Adjustment**: You can click the **Rotate** radio button and hold the left mouse button while dragging the watermark image at left to the desired angle.

3 Specify the **Text Display**. Adjust the number of watermarks printed and the space between them. Enter the number of watermarks in the **Count** text box, or adjust
the value higher or lower. Enter the value for separation between watermarks in the **Separation** text box in millimeter, or adjust the value higher or lower.

4. Click the [OK] button to complete the **Watermark Properties** settings.
Deleting Watermark Text

Watermarks that you have created can be deleted. To delete watermark text that you created, follow these steps.

1. Click to remove the check mark (✓) from the **Disable Feature** check box.

2. Display the watermark for deletion.
3. Click the **Delete** button.
4. Click the **OK** button to complete the process.

Editing the Added Watermarks

Edit your own watermarks following these steps. When editing your added watermarks, you can change the watermark text or the font, color, size, and style.

1. From the **Print** dialog box of the application, access the printer **Properties**. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).
2. In the **Properties** dialog box, click the **[Watermark]** tab.
3. Click to remove the check mark (✓) from the **Disable Feature** check box.
From the **Watermark Selection** drop down list, click to select the text for editing.

Click the [**Edit**] button. The **Watermark Properties** dialog box is displayed.

Next, adjust the text position and other settings as desired. For further details, refer to the instructions on *Adding Watermarks* on page 62, steps 5 to 10, as well as *Positioning Watermarks* on page 66, steps 1 to 3.

**Watermark Page Settings**

Specify the page or pages on which the watermark will be printed.

1. In the **Page Specification** options, click to select the page for printing the watermark from **All pages**, **First page only**, **All pages except first page**, and **Only on specified pages**. If you select **Only on specified pages**, specify your preferred pages in the text box. For example, to print the watermark on pages 1, 3, 5, 6, 7, 8, 9, 10, 11, and 12, enter ‘1,3,5-12’. To select the cover page for printings the watermark, you must select **All pages** in the **Page Specification** and set the cover mode in the **[Advanced Media Settings]** dialog in **[Advanced Media Settings]**, specify Front or Front and Back.

2. Click the [**OK**] button to complete the watermark page settings.

This concludes the settings for printing watermarks.
Adjusting the Imaging Settings

The settings for Print Quality, Grayscale Adjustment and TrueType Fonts are described below.

1. From the Print dialog box of the application, access the printer Properties. For further details, refer to Basic printing tasks, steps 2 to 6 (page 19).
2. In the Properties dialog box, click the [Imaging] tab.
   Each setting option is described below.

Print Quality

You can specify the printer settings for Resolution and Draft. Resolution refers to the number of dots printed in one inch. Higher resolution enables more accurate printing of details.

Click to select the Print Quality from the Print Quality drop down list.
**Grayscale Adjustment**

Used for adjusting the **Brightness** and **Contrast** of graphics. This setting does not affect text. In the **Grayscale Adjustment** section, use the mouse to drag the sliders horizontally toward + or - for **Brightness** and **Contrast**. Alternatively, adjust the

<table>
<thead>
<tr>
<th>Print Quality</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Quality</td>
<td>Prints using the highest printer resolution.</td>
</tr>
<tr>
<td>Proof</td>
<td>Prints using the second-highest level of resolution.</td>
</tr>
<tr>
<td>Draft</td>
<td>Prints at a resolution of 600 dpi.</td>
</tr>
<tr>
<td>Custom</td>
<td>Click the button next to the drop down list (...) to display the Print Quality Settings dialog box, and then access the Custom settings. You can specify your preferred combination of settings for Resolution, Image Refinement, and Draft. For further details, refer to the instructions below.</td>
</tr>
</tbody>
</table>

**Custom Settings Options**

<table>
<thead>
<tr>
<th>Custom Settings Options</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Choose 1200 dpi fast mode, 600 dpi, or 300 dpi.</td>
</tr>
<tr>
<td>Image Refinement</td>
<td>Image Refinement smoothes the outline of text and vector graphics.</td>
</tr>
<tr>
<td>Draft</td>
<td>For more efficient use of the toner that is applied to the paper during printing. Enables you to use toner cartridges longer. Printing will appear lighter.</td>
</tr>
</tbody>
</table>
levels by increasing or decreasing the values in the boxes at right. Adjust in the positive direction (+) for brighter images and stronger contrast.

<table>
<thead>
<tr>
<th>Grayscale Adjustment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Brightness</strong></td>
<td>For adjusting the brightness of graphics. The darkest setting is -100 and the brightest is +100. Choose 50 for a regular level of brightness.</td>
</tr>
<tr>
<td><strong>Contrast</strong></td>
<td>For adjusting the contrast (the proportion of light to dark) of graphics. The faintest contrast setting is -100 and the strongest is +100. Choose 50 for a regular level of contrast.</td>
</tr>
</tbody>
</table>

**Font Downloading**

This setting specifies the method used to send TrueType fonts to the printer during printing.
Even if you specify to send TrueType fonts to the printer as outline fonts or bitmap images, for common fonts, the printer will perform substitution using fonts resident on the printer in some cases. To prevent any substitution of TrueType fonts with printer fonts, click to add a check mark (√) in **Disable Device fonts**.

### Selecting Fonts for Substitution

By clicking the [Font Substitution] button, you can select the fonts that are substituted by the printer for the fonts specified by print jobs.

1. Click the [Font Settings] button to display the **Font Settings** dialog box.
2. Select among **Download TrueType fonts as outline**, **Download TrueType fonts as bitmap**, and **Substitute with Device fonts**.

If you select **Substitute with Device fonts**, you can choose which printer fonts are used for substitution. Click **Substitute with Device fonts** to activate the [Font Substitution] button. Clicking the button will display the **Font Substitution** dialog box. In the **Font Substitution** dialog box, the fonts installed on your computer are listed in the **System Fonts**, and the printer fonts are listed in...
Available Device Fonts. For each system font, select your preference for substitution from the Available Device Fonts, and then click the [OK] button.

1. Click the [Graphics Settings] button to access the Graphics Settings dialog box.
2. In Optimization, select the graphics transfer method from the following two selections. Click the drop down list to make your selection.

<table>
<thead>
<tr>
<th>Optimization</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fast Printing</strong></td>
<td>Decreases spool size and increases print speed. Select this option for regular printing needs.</td>
</tr>
<tr>
<td><strong>Document Portability</strong></td>
<td>Creates a PostScript file in ASCII text encoding. Unlike the binary format created in Fast Printing, the ASCII text created with this selection can be edited.</td>
</tr>
</tbody>
</table>
3 The check boxes in Options underneath Optimization offer the following settings.

<table>
<thead>
<tr>
<th>Options</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Text as Black</td>
<td>When printing colored or gray text in monochrome mode, the text that would otherwise be printed in color is printed using only black, not in gradations as in grayscale mode. This mode does not affect white text or colored graphics.</td>
</tr>
</tbody>
</table>

4 Click the [OK] button to save the Graphics Settings.

This concludes the process for adjusting imaging settings.